WAVsplitter
User Manual
Build 654

This manual is viewable from the Help Menu,
either from the local hard drive or preferably directly from the Internet.

Note: We are continuously improving WAVsplitter, so the screen captures
in this manual may be different from those of the actual program. Select Open
Change History in the Help menu to see the changes which matter to you and
download the update accordingly.

Hint: After clicking on an internal hyperlink, you can come back
to where you were with an ALT-LEFT ARROW.

Sections in yellow are not ready in the software
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Definitions
WAVsplitter allows you to automatically split a single audio file into many Individual Files
whose names are taken directly from a list provided by your client.
Source File:

The audio file recorded outside of WAVsplitter containing all the files
to be produced for the project.
Individual File: Each of the final files that have to be delivered to the client.
Prompt:
Each section of the Source File corresponding to a Individual File.
Pause:
A predefined time that the narrator has to let lapse between the end
of a Prompt and the beginning of the next one.
File Name:
The precise name associated with each Individual File.
Script:
The Excel file containing the name of each Individual File along with
its content, i.e., the text to be read.
Content:
The text read in each Prompt.
Project Folder: A dedicated folder containing all the files related to a project (Script,
Source File, Individual Files, various backup folders created
automatically along the session).
The narrator reads the content of the Script to produce a single Source File, leaving
a Pause in between each Prompt. WAVsplitter associates each Prompt with its
corresponding File Name, then creates automatically all the accurately-named
Individual Files to be delivered to the client.
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Answers to FAQs
Problem
I cannot find my audio
files.
I cannot import a Source
File and Script.
My Script does not import
correctly.

Possible Solution
They are saved in the Project
Folder containing the Source
File and Script you imported.
You need to register, but it’s
free.
The Script needs to be
properly formatted.

See...

Section 16.3.2.1, Register
Annex I
Watch the YouTube
tutorial to get started.

I need to reenter my
Registration Code every
time I start.

When I try to batch
process to .mp3, all my
files disappear.

What about us Mac
users?

You have entered a Trial
code. WAVsplitter is now
asking for a Subscription
code. If you are still evaluating
WAVsplitter, just click “Trial.”
You need to install the LAME
encoder. It’s free but due to
copyrights, WAVsplitter
cannot include it in the
download. The user (you) has
to do that.
Use VMware, Parallels, or
Boot Camp.

Section 13.4,
Resample/Convert Format

Annex II

Still in a bind?
Contact us at mailto:support@Word2WAV.com.
We will make it work for you.
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Menus and Short Cuts
Menu

Title

File

Load Working Files
Backup Source File
Export Individual Audio Files
Quit

Description

CTRL-…

Load audio file and Excel
Use if Auto backup is disabled
Export when finished

L
S
E
Q

Windows WAVsplitter
Batch Processor
Rename Wizard
Open Project Folder
Preferences

Where things are happening
Set silences, normalize, resample, etc.
Edit any file name/date, not just audio files
View all your files in a single location

W
B
R
P

Tools

Toggle whether to play continuously after
click or only while mouse is down
Increase detail of wave graphic
Reduce detail of wave graphic
Undo last audio edit

M

Play Continuously
on Mouse Click
Zoom In
Zoom out
Undo

Help

About
Open
Manual

From Internet
From Local Drive

Open
WAVsplitter
Tutorials Presentation
Batch Processing
Script Formatting
Revision History
Register WAVsplitter

F1
F2
Z

Opens the latest manual from the Internet
Opens the manual located in the WAVsplitter
folder
General presentation of WAVsplitter
(on YouTube)
Ignore the intro related to Word2WAV
(on YouTube)
Tips to format script
(on YouTube)
Opens the Revision History from the website
Opens the Registration window

System Requirements:
-

Windows XP or newer
Runs well on Intel Mac using BootCamp
2 GB of RAM
10 MB of hard disk space
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Introduction
WAVsplitter is a program intended for studios and independent narrators who need
of record large numbers of audio files, each named precisely.
When developing eLearning, gaming, or telephony packages, it is frequent to have
hundreds or even thousands of audio files, often named apparently randomly by the
developer. Typically, a narrator would record all the files over one or more sessions,
then take considerable time to break the long audio file into a series of smaller files,
and finally name them precisely according to the script.
This operation is tedious and time consuming, and often leads to errors in file naming –
which in turn leads to lost time in quality assurance. This task is worsened in studios
where the technician needs to manipulate files in a language he does not understand
and on which he has therefore little control.
WAVsplitter solves this problem by splitting the long audio file automatically and naming
the resulting smaller files directly from the script – thus eliminating both the need to
manually divide a long file and to name each subfile.

Simply record the script on any computer (PC or Mac) using any software, leaving a
pause between each prompt. Then import the audio file and the script into WAVsplitter
and watch it split the files and name them correctly.
All the mundane tasks are eliminated, thus reducing the production time by many hours
and therefore increasing the profitability of the project.
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Program Overview
Using WAVsplitter, a typical session would proceed as follows:
a. Record the complete Script on any computer using any software,
simply leaving a Pause between each Prompt.
b. Edit the recording using your favorite software to delete double takes,
breaths, page turns, etc. as you normally would.
c. Format the Script according to specifications.
d. Create a dedicated Project Folder containing the Source File and the Script.
e. Check the parameters in the Preference window.
f. Import the Source File and the Script into WAVsplitter.
g. Insert any missing Pauses so that the number of required Prompts is
equal to the number of identified Prompts.
h. Export the individual Prompts named automatically and precisely to
produce the Individual Files to be delivered to the client.
i. Post process the Individual Files (normalize, set head/tail silences,
and/or change encoding).
Each step will be covered in details in the rest of this manual.
WAVsplitter is comprised of two main windows:
 Preferences
 WAVsplitter
Two additional windows are stand alone utilities:
 Batch Processing deals with setting silences, normalizing, and audio resampling
and converting. Not limited to WAVsplitter files.
 Rename Wizard makes it possible to rename any file almost any way you want.
It is useable for all file types on the computer, not only audio files.

Note: If you have done so, take a few minutes to watch the Introduction video to
have a quick understanding of the program. It will make the details below
easier to understand.
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Preference window

WAVsplitter window

Batch Processor window

Rename Wizard window
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1. Format Script
In order to import the Script in WAVsplitter,
it needs to be in Excel and formatted
according to specifications.
For each row of the Script:
- The left column corresponds to
the File Name
- The right column corresponds to
the Content, i.e., the text to be read.
Requirements:
- No header
- Only the first tab is imported
- Needs to be saved as .xls, not .xlsx.
In Excel, use Save As under File and
select:

Ignore any warnings regarding possible
loss of content.
This video gives a few tricks for script formatting.
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Under Script Formatting, two options are available depending on the actual format of
the script. Note that the following example uses an Excel script, but the same would
apply to a Word script.
One File Per Row

Each row contains a File Name on the left
and a Content on the right. In this case,
one WAV file will be created for each row.

Notes: -

Files Split Over Several Rows

Here however, some rows do not contain
any file name. All the content with no file
name will be added to the content above
to create a single entry. In the above
example, the file Intro_b will include 3
paragraphs, Intro_c will include 2
paragraphs, and Intro_d will include 3.
The other rows will be not affected.

Trying to import the script on the right using the One File Per Row option will
create additional files named NoFileName_1, NoFileName_2, etc.
One File Per Row stops at the first empty row, whereas Files Split Over
Several Rows stops at the last row of the table or worksheet.
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2. Project Folder
At the very start of a WAVsplitter project, you must create a dedicated Project Folder
anywhere on the computer. All the files created by WAVsplitter will be saved in that
folder.
Copy or move the Source File and the Script in that folder:

Again, the Script must be in .xls format, not .xlsx.
The Source File can be in .wav or .mp3 format, depending on the selection made in the
Preference window.
WAVsplitter will create a BU_Source_Files folder automatically as explained below.

Page 11

3. Load Working Files
Select Load Working Files under the File menu,
or press CTRL-L, to import the Source File
and the Script.
A dialog box opens to let you select the Source File. Use the regular Windows
browsing functions to locate the Project Folder.
Note: Only the files with the correct extension, i.e., .wav or .mp3, will show, so make
sure the correct format is selected in the Preferences window.

WAVsplitter finds and imports the Script in Excel automatically.
A progress bar shows the import of the content of the Excel file.
See the Preference window to import a section only of the Excel file.
Once the import is complete, the main WAVsplitter window opens.
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4. Building the Waveform
A blue bar shows the progress of the import of the Source File and the building of its
waveform. Once the rendition is complete, the Status returns to Idle and the content of
the table is built automatically.

This process may take a few seconds as several steps are performed as described later
in this manual.
Note that it is advisable to keep the duration of the Source File in the 10-15 minute
range to keep things moving smoothly. This obviously depends on the computer
(processor, RAM, etc.). See the Preference window to define the rows of the Excel
worksheet corresponding to the imported Source File.
The vertical scroll bar on the left can be used to increase or decrease the amplitude of
the waveform.
Several buttons under the waveform allow for zooming in or out.
The Undo button on the right may be used to undo an edit.
Use the top green sliding bar to scroll through the waveform. The time is displayed
above and under the waveform itself.
A bloc of counters indicate various times and durations in “minute:second:millisecond”
format.
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5. Pause
Two parameters define how WAVsplitter identifies the Prompts within the Source File.
Duration:

The minimum time in milliseconds that must be left blank between each
Prompt.

Threshold:

The level in dB under which this blank must remain in order to be
considered a silence.

These 2 parameters are specified in the main WAVsplitter window in order to be easily
modified to fit each project.

In the example above, any portion of the audio which remains under -35 dB for longer
than 1500 msec will be considered a Pause which will be used by WAVsplitter to detect
the end of a given Prompt and the start of the next one.
Note: If the pause is shorter than 1500 msec or if the
level raises above -35 dB anytime during that
pause, it will become invalid and WAVsplitter will
interpret this pause as a regular part of the
speech, meaning that the prompt preceding and
the prompt following that incorrect pause will be
combined.
However this can be fixed easily as indicated below.
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6. Table
Once the Source File has been imported and its waveform created, WAVsplitter tries to
identify the various Prompts and associate them with their corresponding File Names
extracted from the Script.
The table thus created can be divided in 3 areas:

The first 3 columns contain the information extracted from the Script, namely the row
number, the File Name and the corresponding Content. This information cannot be
edited.
The next 3 columns contain the time information, namely the Start time, End time, and
Duration of each Prompt that WAVsplitter has detected and matched with the
corresponding File Name and Content. Note that this will most likely be inaccurate on
the first pass and will have to be fixed as detailed later in this manual.
The last 3 columns show the number of words in the Content corresponding to the
Prompt, the Projected duration of that Prompt, and the Variance, i.e., the percentage
difference between the Actual duration and the Projected duration of the Prompt. See
next page for detail.
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7. Variance

Since the speed of the read depends on the narrator and/or the project, first specify its
value in words/min in the box above the table. Assuming you speak at 150 words per
minute as in this example, each word adds 400 msec on average to the total time of the
Prompt.
For each Prompt, WAVsplitter determines the Actual time of the prompt as well as the
theoretical or Projected time based on the Number of words x Speed (words/min).
So, for Row 1 for instance which contains 7 words, the Projected time of the Prompt is
2,800 msec while the Actual time is 3,483 msec.
The Variance, or percentage difference, is calculated as (3,483 – 2,800)/2,800 = 24%.
Experience shows that anything under 50% is acceptable.
When the Variance is greater than the default value defined in the Variance box above
the table, 3 entries (Actual time, Projected time, and Variance) are outlined in red to
draw attention to these unusual values which may indicate an error in the parsing of the
Source File.
Adjust the default value of the Variance up or down depending on the nature of the
project. In general, the longer the Prompts, the shorter the Variance should be.
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8. Checking Accuracy of the Splits
Assuming everything has worked as planned, for each row, the audio of the Prompt
should match the text of the Content.

Let’s look at Row 4 for instance in the above example. The table indicates that the
Prompt should start at 14.656 seconds and end at 16.405 seconds, for a duration of
1.749 seconds.
Note that the Projected duration based on the speed (words/min) is 1.600 seconds,
resulting in a low Variance of 9%. It is therefore reasonable to believe that the Prompt
has been isolated correctly by WAVsplitter.
Click anywhere on that row, keeping the mouse button down. The cursor jumps to
14.656 seconds and the audio start playing at that location. You should hear the text of
the Content corresponding to that Prompt. Release the mouse button to stop the audio.

Note:

This mouse down/up feature makes it possible to check Prompts very quickly
throughout the Script/table. Use CTRL-M (or the Preferences window) to
toggle this function so the audio keeps playing once the mouse is released.

Note:

Look at the Names and Audio counters.
Green means that WAVsplitter has detected
the correct numbers of files, while red indicates
one or several errors.
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9. Finding Errors
If these counts are different or if the audio of a Prompt does not correspond to the
Content, the error need to be fixed. Common causes are double takes and incorrect
pauses, either too short (less than the Duration) or too loud (above the Threshold).
Let’s look at the last column of the table labeled Variance. Variance is the percentage
difference between the Actual and the Projected durations of the audio for a given
Prompt. Since the words per minute is a rough measurement, we can expect a
difference, but a reasonable one. A 50% variance is usually reasonable. In the table,
any variance greater than the default Variance will turn the last 3 rows red for easy
detection.

Simply go down the Variance column to find the values which are way off (red). Here
Row 6 shows a 337% variance: the “detected” prompt is 3.5 seconds although it should
be less than 1 second.
Click on the next row. You should hear the Content of Row 7, but you hear the Content
of Row 8. Why? Because the pause between prompts 6 and 7 is too short, so both
audios for 6 and 7 were interpreted as a single prompt.
Note: All prompts after 6 will be incorrect, so the pause between 6 and 7 needs to be
fixed first.
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10. Fixing Errors
To fix an incorrect pause, click on the waveform between the 2 incorrectly spaced audio
segments. A yellow line appears at that location. Click the Insert Silence button on the
right. WAVsplitter inserts the minimum Duration value so we are sure the new pause is
long enough.

Once the waveform has regenerated and the table has been recalculated, you can see
that the error is gone!
Repeat the process going down the Variance column to fix the remaining errors until the
file counts match.
An error may be caused by 2 other problems, namely noise or extra audio.

If the pause if long enough but interrupted by a noise, which is anything above the
Threshold, like a cough or a page turn, simply select it by dragging the cursor over it,
then click on the Flatten Selection button.
If you have a double take, select it by dragging the cursor over the unwanted audio,
then click on the Delete Selection button.
When using either of these 2 buttons, make sure the resulting pause is still long
enough. Use the Insert Silence button as required.
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11. Exporting the Individual Files
Once all errors have been resolved, select Export Individual
Audio Files from the File menu, or press CTRL-I.

A dialog box opens with a status bar showing the progress of the export.
Once all the files have been created, three options are available:
- Start a new session
- Open the Project folder ------------------------------------------------------>
- Open the Batch Processor to process the Individual Files
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12. Preference Window
If the Script is very long, it is advisable to
create several shorter Source Files.
10-15 minutes is usually appropriate.
Select this option to specify the rows to
import.
When this option is selected, the Source
File is backed up in a BU_Source_Files
folder created at the beginning of the
project after each edit. If space is a
problem, deselect this option and use
CTRL-S to backup manually.
While clicking on a row in the table triggers
the play of the corresponding Prompt, this
option makes it possible to stop or not the
audio when the mouse is released.
Toggle this option with CTRL-M regardless
of this setting.
This option adds a silence of the specified
length at the beginning and at the end of
each Individual File when they are
exported.
Select whether the Source File is in .wav
or .mp3 format. The exported Individual
Files will be in the same format. Only the
Source File with this extension will show in
the dialog box when importing the Source
File.
If the client does not specify File Names
for the exported Individual Files,
WAVsplitter can create them
automatically.
The first option assumes the Excel file
contains 2 columns (File Name and
Content), while the second option
assumes it contains only one column
(Content).
The Preview shows the first 3 File Names
which will be created based on the
4 parameters. The extension is the one
selected above.
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Preference Window (Cont’d)
Not Ready Yet
This option specifies whether the Script is
formatted as one file per row or with the
files split over several rows.
On a few computers, the table is not
regenerated correctly when importing the
Script or changing the parameters in the
WAVsplitter window. In this case, it
displays a lot of “00:00:00” instead of the
correct values. Click on the Process button
above the Variance column to display the
correct values. Try various values like 500,
1000, or 2000 to see if the problem
disappears. Let us know if you experience
this problem since it only affects random
computers. This option will be deleted
once the problem has been fixed.
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13. Batch Processing
Note: This utility can be used with any audio file, not only those created by
WAVsplitter.
This utility makes it possible to batch process files as follows:
- Cut beginning and/or end of each file by a specific duration
- Set a specific silence at the beginning and/or end of each file
- Normalize the files
- Resample the files
- Convert the files to a different format.
Choose Batch Processor in the Windows menu or simply press CTRL-B to open the
Bach Processor window.

By default, the path points to the Project Folder where all the Individual Files which have
been produced by WAVsplitter are stored.
To use this utility independently of WAVsplitter, use the Browse button to locate the
folder of interest.
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Before processing the files, WAVsplitter creates a RAW_WAV_Files folder inside the
Project Folder and moves all the WAV files in this back-up folder. The processed files
are then saved back in the Project Folder. This way, all the final (processed) files are
located in the Project Folder, while all the original files are backed-up in the
RAW_WAV_Files folder.
Notes: -

The RAW_WAV_Files folder must be empty before processing the files so
as not to overwrite any original files.
If you make a mistake in processing the files (say you convert them to MP3
while your client really wanted WAV), just delete the MP3 from the Project
Folder, move the original WAVs located in the RAW_WAV_Files folder back
into the Project Folder, and reprocess them according to the correct specs.

WAVsplitter can perform several operations in a single pass, then repeat these steps for
all the files in the Project Folder:
- Cut beginning and/or end of the file
- Set silence at the start and/or end of the file;
- Normalize the file;
- Filter the file
- Resample and/or convert the format of the file.
13.1

Cut the Beginning and/or End of the File

Note: This step is not required if the files have been processed by WAVsplitter.
Use this function to truncate the beginning an/or end of each audio file before applying
the filters. People using excessively sensitive mics get an audible click at the beginning
an/or end of their recordings. These clicks are difficult to remove without changing the
silence threshold. For a given setup, the clicks will always be at the same 'distance’
from the beginning and/or end of the files. Experiment to find the best values for your
set-up. 20 msec and 300 msec for beginning and end, respectively, are good starting
points.
- ‘0’ will bypass the corresponding beginning or end cut.
- Uncheck to bypass both beginning and end cuts.
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13.2

Set Silence

The Threshold is the level under which the sound is
considered to be silence.
In this example, the white area shows some noise which
can be considered silence if the threshold is high enough.
A recording always contains the ambient so silence
is never zero, but a level low enough to be considered
zero. Experiment with what works for you.
Common values are -26 dB to -40 dB.
Note: The Threshold can be entered either in dB or in %RMS.
WAVsplitter calculates the other value.
-

Select the first option to set the silence at the start and at the end of the file. In the
above example, silences are 200 msec. and 300 msec.

Note: The values specified are expressed in milliseconds (500 msec. = 0.5 second).
Once processed, the silence will be equal to the set value, regardless of whether
it was originally longer than, equal to, or less than said set value.
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13.3

Normalize

Check Normalize to a Maximum Value. The maximum can be expressed in dB or in
%RMS. When you enter a value, WAVsplitter calculates the other value. Full scale is 0
dB or 100%. A common value is -0.3 dB or approximately 97%.

13.4

Resample/Convert Format

Check Resample and/or Convert Files.
Note: If Resample and/or Convert Files is unchecked, WAVsplitter recalls the
parameters used to record the original sound files (as defined in the Setup
window). In this case, the files retain their original properties.
Specify the parameters you need. Current options are resampled WAV, MP3 (above
example), ACM (including µ-Law), and AIFF.
Note: In order to export to MP3, Lame.exe, an external freeware and open source
command line encoder, must be present in both the C:\WAVsplitter_v3 folder and
the Windows\Systems32 folder. Lame.exe can be downloaded from the Internet
(http://www.free-codecs.com/download/lame_encoder.htm for instance) and
simply copied to both the C:\WAVsplitter_v3 folder and the Windows\Systems32
folder.
If the file is down-mixed to a lower frequency, an anti-aliasing filter is applied.
Once all the parameters have been specified, click on the Process button. A progress
bar will open to show the processing of the files.
Once complete, all the processed files are located in the Project Folder, ready for
delivery.
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Notes: -

The original unprocessed files are stored inside the RAW_WAV_Files folder
inside the Project Folder.
All the back-up takes are stored in the BU_Takes folder inside the Project
Folder. These backup files are not batch processed.
If the Lame encoder is not found, no MP3 files will be created and the
Project Folder will be empty after processing.

All the selections and values are saved when the files are processed and recalled next
time the Batch Processor window is opened
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14.

Rename Wizard

Note: This utility can be used with any file on your computer, not only those created
by WAVsplitter.
See next
page for an
explanation
of these
features.

Select a Drive, navigate
to a folder, then click on
it to display all the files
in the left column.

Display the 2 columns
vertically or horizontally
to accommodate many
files or long file names.

Restrict files to extension(s)
and/or name content.

See next page for an
explanation of this feature.

Displays date attributes of first file
only, but all files are changed
proportionally using their actual
date/time. All changes in hours, use
minus to backdate files.
Example:
To postpone date by 4 days,
enter 96.
To backdate 4 days,
enter -96.
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Options
Specify the change(s) you want to make using the options available, then click on
Preview. The change(s will be reflected in the right column.
Click on Cancel to ignore or Rename to proceed with the change(s).
Add Prefix – Enter a fixed prefix, or leave blank and check one of the 2 check
boxes below to add an increasing number or letter in front of the file names.
Examples: 1_xxx, 2_xxx, 3_xxx.
Add Suffix – Enter a fixed suffix, or leave blank and check one of the 2 check boxes
below to add an increasing number or letter after the file names, before the
extension.
Examples: xxx_A.ext, xxx_B.ext, xxx_C.ext.
Search For/Replace With – Search and replace any string in the file name, including
extension. Can be made case sensitive.
Insert String – Insert any string starting at position xx.
Remove # Characters – Remove any number of characters starting at position xx.
Change Extension – This is not a file converter, it just renames the extension. It is
case sensitive.

Rename Per List
1.

2.
3.
4.
5.

Create an Excel file containing the current names and the corresponding desired
names of a series of files:
In this example, the file named “Current name A”
will be renamed “New Name A, the file named
“Current name B” will be renamed “New Name B,”
etc.
Place the Excel and the files to be renamed
in a dedicated folder.
Click on Rename Per List and locate the Excel file
using the regular Windows browsing technique.
Click on the Excel file.
WAVsplitter will create a Back-up folder, move
the original files in this folder, then copy and
rename each files according to the list in
the Excel file and place them in the folder.
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15. Help Menu
15.1 Open Manual
This manual is viewable from the Help menu, either from the local drive or preferably,
directly from the WAVsplitter website.
The manual on the local drive corresponds
to the version of WAVsplitter you first installed.
It is therefore preferable to open it from
the web since this way you will always
access the latest version.
If you prefer to access it from your local drive, download an updated version as
appropriate from the website and save it in the WAVsplitter folder.

15.2 Open Tutorials
Choose from the list of available tutorials.
These tutorial are located on YouTube,
so you need to be connected to the Internet.
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15.3 About
This screen shows the following information:
Build

Demo, Trial
or Subscription

Licensed entity
Registration code
(or Installation ID if waiting
for a Trial code)
Make sure you include the Build and registration code when contacting us for support.
You can just attach a screen grab to your email.
All information sent during the Registration process can be viewed by clicking “Show
Full Registration Data” in the bottom left corner.
To renew your Subscription form one year to the other, click on “Renew Subscription”
located in the middle right to enter your new Subscription code.

15.4 Register/Purchase
This menu only appears when you can register or purchase the software.
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16. Program Installation
The WAVsplitter website (www.Word2WAV.com) offers two options:

It is very important that you use the option which is right for you.

16.1 Download Demo
-

Use Download Demo only if you are downloading WAVsplitter for the
first time!

-

If you are a Registered user, use Download Update. See 13.2 below.

WAVsplitter_Full_Instal.exe installs all the necessary components on the PC and
creates a WAVsplitter folder in the C:\Program Files folder, containing the WAVsplitter
program itself (WAVsplitter.exe) and a WAVsplitter.mdb database among other things.
Since your Trial or Subscription code is saved in the WAVsplitter.mdb file, a new full
install would erase it. If you have already registered, do NOT use this option. Use
Update instead.
Note: You can change the WAVsplitter folder location at Install time only.
The full install is around 5.5 MB. Download it in any directory of your choice, then
double click on the file (WAVsplitter_Full_Intall.exe) to launch the installer.
Just follow the prompts. All defaults should be OK.
A shortcut is created on the desktop.
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16.2 Download Update
Updates are posted regularly to fix bugs or implement changes and/or additions.
Check Change History in the Help menu regularly to see if there are any updates of
interest to you.
Each update is identified by its Build number (e.g., Build 651).
The current Build is displayed in the title of the WAVsplitter frame.
Use this Update option if you have already registered your copy of WAVsplitter, whether
for a Trial or a Subscription. Simply download the file (WAVsplitter_Update.exe) and run
it by double clicking on it to update the required files.
Again, do not use the full install if you are registered.
No other action is necessary. Verify that the Build in the title bar has been updated.
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16.3 Steps Required to Use WAVsplitter
Step

Features

Download the Demo

As downloaded, all WAVsplitter functions are enabled,
except Export Individual Files, Batch Processor,
and Rename Wizard.

Register for a Free
30-Day Trial

Register to use a fully-functional Trial copy for 30 days –
ABSOLUTELY FREE.

Purchase a 1-year
Subscription

Requires payment of the subscription fee.
No more nag screen for the duration of the subscription.

See below for more information on each step.

16.3.1

Demo Version

As downloaded, the Export Individual Files functionality is disabled. The Batch
Processor and Rename Wizard utilities are also disabled. However, you can start
testing most of WAVsplitter’s functionality.
When you launch WAVsplitter, click on the yellow Demo button to use WAVsplitter in
Demo mode and test its capabilities and features. You can complete all the steps of a
project, except the last one, Export Individual Files.
Do not hesitate to e-mail us at support@Word2WAV.com with any questions or
comments you may have during your evaluation. All requests to add or modify features
will be taken into consideration, whether you are a registered user or not, although
preference will obviously be given to paid users.
If you believe that WAVsplitter can save you significant time in the splitting and naming
process, it is time to register for a 30-day trial to be able to complete a few projects at
no cost.
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16.3.2

Trial Version

16.3.2.1

Register

Launch WAVsplitter and click on the green Register button to open the Registration
dialog box.
Please fill the six fields, confirming your
e-mail. The Trial code will be sent to that
e-mail so make sure it is correct.
Company name will be displayed in
the About window after registration along
with the Trial code you will receive.
All fields must be filled. WAVsplitter warrants
that the information collected will be used
strictly for the purpose of issuing a code and
not communicated to any third party for any
reason whatsoever.

Once all the fields have been filled and
verified, click on Process. WAVsplitter will
calculate your Installation ID and display it
for reference.

You must copy the information in the yellow
block and email it to support@Word2WAV.com
to complete the registration process.
Do NOT send a screen capture! Copy the
data and paste them in your email.

You can continue using WAVsplitter in Demo mode until you receive your Trial code.
You can expect to receive it within one business day.
Once you are convinced that WAVsplitter can save you significant time in the splitting
and naming process, it will be time to purchase a Subscription (see 16.3.3 below).
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16.3.2.2

Log On

Launch WAVsplitter and paste the Trial code you received in the Registration cell. This
number needs to be exactly as sent, so it is preferable to copy and paste than to retype.

A dialog box will confirm that WAVsplitter has been registered on your PC. Click
Continue to proceed.

16.3.3

Subscription

Next time you launch WAVsplitter, you will be
reminded that you are in a 30-day trial period.
Please visit our website at www.Word2WAV.com
or just click on Purchase to send your payment.
Do not forget to indicate your Trial code.
If you have a Subscription code, just copy it in
the green field and click Subscription.
WAVsplitter will launch without any nag screen
as long as your subscription is valid.
Otherwise, just click Trial to remain in the Trial mode until the Expiration date. Past that
date, WAVsplitter will revert to the Demo mode.
IMPORTANT:
 The Trial and Subscription codes are saved in the WAVsplitter.mdb file
located in the WAVsplitter folder.
Do NOT rename or alter this WAVsplitter.mdb file in any way.
 The registration is valid for the PC sending the registration request ONLY. This is
a single PC license. If you move WAVsplitter to another PC, reformat your drive,
etc., you will need to get another Trial or Subscription code. This will be provided
to you at no charge. Just contact us as support@Word2WAV.com.
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17.

Support

If you have any questions or comments about WAVsplitter, whether during your
evaluation or actually using it, do not hesitate to e-mail us at support@Word2WAV.com.
Note: You must have the latest Build installed before contacting us for technical
support. Please check the WAVsplitter website at www.Word2WAV.com for the
latest Build.
All requests to add or modify features will be taken into consideration, whether you are
a permanent user or not, although preference will be given to paid users. You can
expect a confirmation within one business day.
Please indicate your name and phone number if desired so we can contact you to
discuss the problem as needed.
Thanks for using WAVsplitter!
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Annex I
Script Formatting
See YouTube video in addition to this annex.

General
For the purpose of this annex, a script is defined as a series of entries which need to be
recorded as audio files. Since each unit will ultimately be saved as an audio file, this
annex refers to each entry as a file.
Each file is typically (but not always) made up of a File Name and a Content.
Therefore, an ideal script would look like a 2-column table...
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Notes: 



See Automatic Naming if the client does not provide specific names for the
audio files.
Delete the first rows if they contain header or non recordable items.

The import process stops at the first empty row. If only a portion of the script is
imported, check that there are no empty rows inserted in the script.
Note: See Files Split Over Several Rows to ignore blank rows.
The information must be in the leftmost rows (A and B). Delete all left rows which
are not to be imported.
The information must be in the first tab. Move the tab to the left most position as
required.

Formatting Requirements
Unless you are using Auto Naming, the content of the left most column is used to name
the audio files. Therefore, only valid Windows characters can be used in this column.
Windows does not accept certain characters in the file names, in particular:
 Return / Line feed / Tab
 /\:*?“<>|
If an illegal character is used in a file name, WAVsplitter replaces it with a “+” sign when
importing the script.
Note: Once the script has been imported, WAVsplitter lists all the formatting errors. You
can then accept the substitutions or correct the script and reimport it.
In order to optimize display in the table, avoid Returns before the text in the Content
cells.
Notes: -

You may want to look at this link to learn a lot of tricks to reformat your
script:
http://word.mvps.org/faqs/general/usingwildcards.htm

-

The key element is to find a pattern in the source script and exploit it to
reformat the text automatically.
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Formatting Checks
When importing the script, WAVsplitter checks for the following errors:
 No file name,
 Empty content,
 Duplicate file name, and
 Illegal Windows characters in the file name
If any of these errors is detected, WAVsplitter will correct it as follows:
Error Description
No file name

Correction
Error Code
“NoFileName_x” is inserted, where x
N
is incremented from 1 up
Empty content
“EmptyContent!” is inserted
E
Duplicate file name
The file name is used, and “_X2” is
D
added to the second occurrence,
then “_X3,” etc.
Illegal Windows characters in
The illegal character is replaced by
I
the file name
the “+” sign
Once the script has been successfully imported, a confirmation message displays the
total number of files imported. Check this number to make sure all the files were
imported. If not, check the row following the last imported row to make sure it is not
empty for instance since an empty row terminates the import process in Excel.
The confirmation message will also display the number of errors, if any. You will then
have the opportunity to review these errors and decide whether to accept the
substitutions or correct the script and reimport it.
Note: If you have any problem formatting your scripts, email us at
support@Word2WAV.com and we will help you with that step. Once you have
understood the requirements, it will become a routine task of only a few minutes.
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Annex II
WAVsplitter on the Mac
Many narrators are using WAVsplitter on their Mac using VMware or Parallels.
Although VMware is reported more frequently, try both since each setup is different.
A third option is Boot Camp. We (the developers) are checking all new Builds on a Mac
Mini running Boot Camp and Windows 7.
If you have specific questions, please contact us at support@Word2WAV.com.
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Notes

